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B 

Exercise Introduction 

1. Exercise Aim and Plan 

The purpose of this part of the present exercise is to investigate the operation of a MOSFET in 
its typical application, which is a DC/DC converter. In this circuit, the transistor is a component of a 
single-pole double-throw (SPDT) semiconductor switch whose role is to switch over a current from 
one branch to another one. The converter example enables to get acquainted with the pulse width 
modulation (PWM) method of controlling power semiconductor devices. 

This exercise demonstrates that the switched-mode technique using power transistors enables to 
accomplish useful functions in DC circuits together with achieving high energy conversion 
efficiency. As always, this has some limitations, introduced in a great part by the semiconductor 
switch itself. At the end, its properties will be related to those of the complete converter. 
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2. DC/DC Converters 

2.1. Recommended reading 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

A Ben 4.5 2.1.a—b   

Additionally, from Manual 0 references: 

0 B Eri 1.1 2.1.b, 2.2a—b, 
2.3.a,c,d, 3.1.a—b 

  

0 E Ras 6.2 2.2, 2.3.a—c  2.2 
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2.2. Switch-mode control 

Obtaining the switch-mode operation of a converter circuit requires switch-mode control of 
semiconductor devices instead of continuous (linear) control. A controlling quantity x (current or 
voltage) then takes the form of a pulse wave. It consists of periodically repeated pulses, i.e. sections 
of a level higher than the idle one,  whose shape, to simplify, can be considered rectangular [see Fig. 
1(a)]. 

A pulse wave is described by the following parameters: 

(1) period of repetition Tp which is of course the shortest time after which the 
waveform repeats, so e.g. the interval between the beginnings of successive 
pulses; 

(2) frequency of repetition fp which is the inverse of the period of repetition 

 
p

p

1

T
f =  (2.1) 

(3) pulse width tp which is the duration of the top of the pulse; 

(4) duty cycle (also called duty ratio) D which is the ratio of the pulse width of the 
period of repetition: 
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Fig. 1. Pulse wave and its basic parameters: (a) the ideal waveform; (b) a waveform with finite edge steepness 
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 As it can be easily seen, just one of the parameters 1 or 2 and one of the parameters 3 or 4 are 
sufficient for an unambiguous description of a pulse wave in the time domain. 

In the domain of the given electrical quantity (current or voltage), a pulse wave is described by: 

(5) low level XL which is the value of x corresponding to the base of the pulse; 

(6) high level XH which is the value of x corresponding to the top of the pulse; 

(7) amplitude Xm which is the distance between the low and the high levels 

 LHm XXX −=  (2.3) 

As it can be seen, any two of the parameters 5 to 7 are sufficient for an unambiguous description of 
a pulse wave. 

In power electronics, very often waveforms with a zero base level (XL = 0) are met, for which 
XH = Xm. Because of the prevalence of this case and due to the considerable simplification of 
relationships that are obtained, it is usually the zero base level that is assumed in analysis. 

The above mentioned parameters fully describe only ideal pulses. In power electronics, it is the 
non-zero edge duration that is the most often considered feature of a real pulse wave. These edges 
are described by [see Fig. 1(b)]: 

(8) rise time tr, i.e. the time it takes for the waveform to rise from 10% to 90% of its 
amplitude, which is a measure of the duration of the rising edge (also called the 
leading edge); 

(9) fall time tf, i.e. the time it takes for the waveform to fall from 90% to 10% of its 
amplitude, which is a measure of the duration of the falling edge (also called the 
trailing edge). 

Other nonidealities (e.g. overshoots, settling time, jitter) usually do not affect the macroscopic 
operation of model (academic, ideal) converters. We will therefore neglect them. However, taking 
them into account becomes necessary at the optimization stage of physical (real) circuits where they 
can cause undesirable microscopic phenomena adversely affecting the overall system operation. 
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3. Buck Converter 

3.1. Recommended reading 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

B Eri 2.1, 2.2 2.3.a,b,d, 3.1.b, 
3.2.a—b 

  

   3.1.c—f  3.2 

E Eri 4, 4.1.1, 4.1.5 3.1.c, 3.2.c   

F Eri 4.3, 4.3.1 3.3.a,f; #3
A
 3.3.c   

   3.2.d, 3.3.b—f  3.3 

   3.4  3.4 
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3.2. Buck converter passive components 

3.2.a. Inductor effect 

The role of the two passive components of the buck DC/DC converter—the inductor (choke) and 
capacitor—may be analysed from the signal point of view (low-pass filtering) but also from the 
power transmission point of view. Most receivers (e.g., microprocessors) require constant power 
supply. A buck converter without an LC filter is called ‘voltage chopper’ because its input voltage 
appears at the receiver as ‘chopped’. Power flow is therefore temporarily and periodically 
interrupted. 

Wired power transmission necessitates charge motion in a conductor, or current. Thus, constant 
power delivery necessitates uninterrupted current flow. To obtain it, a component should be 
inserted into the circuit that will prevent the output current from immediately dropping down to 
zero in the moment of switch opening. The inductor is well known for this property which follows 
from energy conservation principle. It says that any change in energy of a system (in this case, the 
inductor) may only result from additional energy being delivered from outside. No energy can be 
delivered in zero time as this would necessitate infinite instantaneous power 

 
t

W
p

d

d
=  (3.1) 

which is unrealistic. Thus, neither can inductor’s energy change abruptly. This energy WL is 
accumulated in magnetic field caused by the current iL flowing through the inductor; they are 
related to each other by 

 
2
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L

L
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W =  (3.2) 

where L is the inductance of the inductor. Therefore, the current through an inductor cannot change 
abruptly. 

In order to make current through the receiver (load) continuous, the inductor must be inserted 
so as the receiver current io flows through it, thus in series. This is shown in Fig. 2(a). 

3.2.b. Analytical description of the inductor 

In each of the two sub-intervals of the switching period, the inductor is found in a series RL 
circuit which is described with Kirchhoff’s voltage law 

 vvE += L  (3.3) 

where vL is the voltage across the inductor and E is an effective forced voltage which is Vg in sub-
interval 1 (Fig. 3a) and 0 in sub-interval 2 (short-circuit which is equivalent to zero voltage source, 
Fig. 3b). Using Ohm’s law and inductor equation and taking into account that io = iL during both 
subintervals, we obtain the equation of the RL circuit 

 0
d

d o
o =−+ E

t

i
LRi  (3.4) 

Using any method of differential equation solution, the solution is found to be 
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Fig. 2. Buck converter circuit: (a) with only the inductor; (b) with the 
capacitor added 
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Fig. 3. Reduced circuit topology of Fig. 2(a): (a) during sub-interval 1; b) during sub-interval 2 

where τ is called the time constant and equals 

 
R

L
=τ  (3.6) 

and t0 denotes the beginning of a given sub-interval. Let us apply Eq. (3.5) to either sub-interval. 

1. For sub-interval 1, t0 = t1. Assume that the current is zero initially: io(t0) = 0. 
Then, 
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Substituting t = t1 and t = ∞ we have 
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which complies with our assumption, and 
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 (3.9) 

The current therefore changes exponentially, rising from 0 up to Vg/R. This has 
been illustrated in Fig. 4(a). 

 
Fig. 4. Output current waveform: (a) without an inductor; (b)  with an 
inductor (Fig. 2a) of small inductance (τ ≪ Ts); (c) with an inductor if 
large inductance (τ ≈ Ts) 

2. At the beginning of sub-interval 2 (t0 = t2), the current equals that at the end of 
sub-interval 1. We therefore obtain 
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Substituting t = t2 and t = ∞ we have 
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which complies with our assumption, and 
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The current therefore changes exponentially, falling from Vg/R down to 0. This 
has been illustrated in Fig. 4(b). 

The time of current settling down depends on the time constant τ. It can be calculated that its 
steady-state value is reached with an accuracy of 1% (0,01) after a time equal τ ln(1/0,01) ≈ 4,6τ. It 
therefore follows from (3.6) that the larger the inductance (for given R), the slower the current rise 
and thus, the stronger the inductor opposes abrupt current changes. In power electronics, an 
inductor of an inductance large enough to visibly slow down current variation in time, is called a 
choke. 

When choke inductance is sufficiently large, current is unable to attain the levels of Vg/R and 0 
at the end of either sub-interval. This is demonstrated in Fig. 4(c). In general, a simplified condition 
for this occurring can be written down as 

 s4 T>τ  (3.13) 

where the number 4 results from rounding the value of 4,6 justified above. Substituting (3.6) 

 
s4 f

R
L >  (3.14) 

As inductor current also flows through the load resistance R, io current has the exact shape of iL. 
According to Ohm’s law, voltage v across the load resistance must also be of the same form. 

3.2.c. Capacitor effect 

Using the inductor, we gained continuous output voltage, but it is still far from being constant. 
In most applications, minimising voltage ripple using only an inductor is impossible as it would 
result in unacceptable size, weight, cost and power loss. Moreover, an inductor is not capable of 
filtering high-frequency disturbance (short spikes and fast oscillations) that are inherently linked 
with switched-mode power converters. 

For the above reasons, a second type passive component must be used: a capacitor. Its energy is 
expressed as 

 
2

2
C

C

Cv
W =  (3.15) 

where C is the capacitor’s capacitance and vC is the voltage across it. It therefore follows from 
energy conservation principle that voltage across a capacitor cannot change abruptly. 

In order to make use of this property, the capacitor must be inserted so that the receiver’s 
voltage v appears across it. Only then it will slow down the variation of this voltage in time. This 
leads to the parallel connection shown in Fig. 2(b). 

3.2.d. Analytical description of the capacitor 

After insertion of the capacitor, the inductor current iL splits into two branches: the capacitor’s 
one and the receiver’s one. According to Kirchhoff’s current law (cf. Fig. 2b) 
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 oCL iii +=  (3.16) 

The inductor current can be considered as the sum of a DC component IL(0) and an AC one iL(a): 

 L(a)L(0)L iIi +=  (3.17) 

where, based on Fourier analysis, the DC component is equal to the average value iL(av) (level I in Fig. 
2.10 of Ref. B). Consequently 

 L(av)LL(0)LL(a) iiIii −=−=  (3.18) 

It is therefore the iL waveform shifted down by its own average value. The iL(a) waveform has 
therefore exactly the same shape but it is varying under and over the time axis (and not under and 
over the DC level I). 

The magnitude of a capacitor’s impedance is given by 

 
fCC

Z
π2

11
C ==

ω
 (3.19) 

For f → 0 we have |ZC| → ∞ which means that for the DC component, a capacitor presents a gap in 
the circuit. Thus, no DC component can ever flow through a capacitor. On the other hand, high 
frequency current components (such as the converter’s switching frequency fs) will easily pass 
through as for f → ∞ we have |ZC| → 0. 

It follows from (3.19) that the higher the capacitance C, the lower the impedance for a given 
frequency f will be. The capacitor C and the load resistance R form a current divider, whose action 
for a given frequency is described by the formulae 
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where I(f) is the rms value of a sine wave current of frequency f. The above relationships can be 
interpreted as follows: 

� the lower the capacitor’s impedance for a given frequency f as related to the 
load resistance, the greater part of a current of this frequency IC(f) will flow 
through the capacitor (the denominator in IC(f) formula decreases, so the whole 
expression increases); 

� thus, the smaller part Io(f) will flow through the receiver (the denominator in Io(f) 
formula increases, so the whole expression decreases). 

In the circuit under consideration, we want to eliminate the AC component from the io 
waveform. Then, the output current io will be constant and so will be the output voltage v across the 
load resistance (by Ohm’s law). As we have noted, the DC component of the inductor current cannot 
flow through the capacitor, thus it entirely flows to the receiver: 

 
)0(L)0(o

)0(C 0

II

I

=

=
 (3.21) 

We could obtain the same result by substituting (3.19) and f = 0 into (3.20). How to redirect the AC 
component to the capacitor? It follows from (3.20) that the condition is 
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because then 
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However, capacitor impedance ZC is dependent on frequency. As we have stated above, the 
inductor current AC component iL(a) is of triangular shape. Based on Fourier analysis, it can be 
represented by a sum of sine waveforms whose frequencies are fs and its odd multiples. Therefore, if 
the condition (3.22) is fulfilled for the frequency of fs, it is also fulfilled for the entire AC component 
of inductor current. This is because other sine waveforms are of greater frequencies (3fs, 5fs etc.) and 
|ZC| decreases with frequency. Thus, the entire AC component of inductor current will flow through 
the capacitor. By substituting (3.19), we obtain the condition (3.22) in the form of 

 
Lsπ2
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3.3. Effect of transistor power loss on converter characteristics 

3.3.a. Input current 

To conduct an energetic analysis of the converter, in order to determine the input power we will 
need to know the DC component of the input current ii. As we have already noticed in Section 3.3.a, 
it is equal to the inductor current iL during sub-interval 1 and zero during sub-interval 2 (see Fig. 3, 
and Fig. 2.8 in Ref. B); hence, by definition of the average value, 
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Let us mathematically transform the result obtained: 
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The expression after the multiplication sign is by definition the average value of the inductor 
current iL over the time interval DTs, i.e. the transistor’s on state duration. This current’s waveform 
is triangular (see Fig. 2.10 in Ref. B), so it consists of two sections of linear rise or fall. It is easy to 
show (either by simple reasoning or formally by integration) that the average value of such a 
waveform is simply equal to the average of the peak and valley values, and that it applies equally to 
the entire period and for each interval separately. Thus, the average over the DTs sub-interval can be 
replaced by the average value over the entire period iL(av), or the DC component IL(0): 

 L(0)L(av)i(0) DIDiI ==  (3.27) 

Using (3.21), we finally obtain: 
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V
DDII == oi(0)  (3.28) 

Thus, in the buck converter, the input current is less than the output current (load) by the same ratio 
as the output voltage is less than the input voltage [see Eq. (2.24) in Ref. B].Taking into account 
(2.24) from Ref. B, the above equation may be converted to a form dependent on the input voltage: 
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The resulting theoretical expression will be useful when carrying out the exercise for checking if 
the system is not drawing too much current, which would indicate an error or malfunction. Then, 
the knowledge of the theoretical input current will be needed also for the circuit from which the 
discussion was started, i.e. the one without passive components (Ref. B of Manual 0). In this case, the 
input current ii equals the output current Io during sub-interval 1 and zero in sub-interval 2 (cf. Fig. 
1.8 in Ref. B of Manual 0).Thus, its DC component is 
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 (3.30) 

A comparison of this result with (3.29) leads to the observation that for D < 1, the DC 
component of the input current is higher when there is no filter in the circuit. It can be easily 
demonstrated that this results from the fact that the active output power in either case is also 
different, despite the same average value of the output voltage. Depending on the waveform—pulse 
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wave without a filter, constant with a filter—this voltage has different rms values which is what 
active power depends on. 

3.3.b. Effect of static power loss on efficiency 

It would be a complicated task to derive an analytical expression for converter efficiency. 
However, we can easily state what influence on the efficiency has the MOSFET transistor 
investigated in this exercise. To limit the number of necessary assumptions for this device parameter 
values, we will begin with static power loss only. We will also assume that inductor current ripple is 
negligible as compared to its DC component; the inductor current may therefore be considered as 
constant, equal IL(0). 

The converter’s average input power is 
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so it is the product of the constant input voltage and the DC component of the input current. The 
latter is expressed with equation (3.27), hence finally 
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Static power loss in the transistor is IL(0)
2
RDS(on) (see Manual 3

A
, Ref. A) during sub-interval 1 and 
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Assuming that the decrease in transmitted power which occurs between converter’s input and 
output results only from the above static power loss in the transistor, we have 
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Applying Ohm’s law to the receiver, we obtain 
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3.3.c. Effect of static power loss on voltage conversion ratio 

To obtain a more informative form of (3.35), we must derive a relationship between input and 
output voltage. We cannot use the relationship from Ref. B because it has been derived for the ideal 
switch. Taking into account the non-zero on-state voltage drop across the transistor VDS(on) (see 
Manual 3

A
, Ref. A), the voltage across the inductor for sub-interval 1 must be expressed as 
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The change of inductor current during sub-interval 1 is therefore (cf. Ref. B and Fig. 3) 
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while during sub-interval 2 it is 
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By equating the above expressions and rearranging, we get 
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Hence, the voltage conversion ratio [denoted M(D) in Ref. B], defined as 
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where Uo and Ui are output and input voltages, respectively, is 
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For RDS(on) = 0, these reduce to the ideal converter formulae [see Ref. B, equation (2.24) and Fig. 
2.5(a)]. In a real converter, the output voltage decreases with an increasing ratio of transistor’s on-
state resistance to load resistance. The discrepancy between ideal and real converter also increases 
when the duty cycle D is increased. 

 
Fig. 5. Average power (solid lines) and converter efficiency η (dotted line) 
as a function of duty cycle D (only static power loss in the transistor is 
considered), for the circuit parameters: Vg = 10 V, R = 1 Ω, RDS(on) = 0.1 Ω 
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3.3.d. Converter characteristics considering transistor static power loss 

By substituting (3.39) to (3.35), we obtain 
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This relationship has been plotted in Fig. 5 for an exemplary ratio of RDS(on)/R = 0.1 which is quite a 
large value, chosen to highlight the observed decrease in efficiency. In fact, a transistor with a 
resistance 10 times lower than the load resistance would be considered improperly selected for a 
given application. Nevertheless, even under such a high resistance ratio, the efficiency only drops to 
approx. 0.9 for D = 1. 

 (a) 

 

(b) 

 
Fig. 6. Converter characteristics as a function of duty cycle D and RDS(on)/R ratio 
(only transistor static power loss has been considered; the value of 0 and the dotted 
line correspond to the ideal converter): (a) efficiency; (b) voltage conversion ratio 
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Thus, the buck converter is not particularly demanding in terms of transistor parameters. Even 
with a poorly selected transistor we get an energy conversion efficiency much higher than in the 
case of linear mode circuits (Manual 0, Ref. E). The buck converter has therefore a high efficiency in 
the entire range of the duty cycle. This makes the step-down topology stand up among DC 
converters. 

As follows from (3.42), for RDS(on) → 0 and for D → 0, the efficiency tends to unity. On the other 
hand, when the duty cycle is increased, efficiency decreases. This decrease is stronger for a higher 
transistor to load resistance ratio. This is confirmed by Fig. 6(a) where efficiency characteristics have 
been plotted for various RDS(on)/R ratios. 

Fig. 6(b) shows the voltage conversion ratio characteristic (3.41). It also proves that in the case of 
the buck converter, an apparent deviation from the ideal characteristic is only observed when the 
transistor is exceptionally poorly selected. 

3.3.e. Effect of dynamic power loss 

To simplify the problem, let us assume that turn-on and turn-off times are equal to a common 
value of tsw. Then, transistor dynamic power loss is (see Ref. F) 
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Using (3.32) and assuming that transistor dynamic power loss is the only cause for efficiency 
decrease, we obtain the formula 
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Fig. 7. Characteristics of efficiency vs. duty cycle D and tsw/Ts ratio (only 
transistor dynamic power loss has been considered; the value of 0 and the 
dotted line correspond to the ideal converter) 

The above relationship has been plotted in Fig. 7 for different transistor switching time tsw to 
converter switching period Ts ratios. It can be seen that the effect of transistor dynamic power loss is 
different than that of static loss: efficiency decreases with decreasing duty cycle. The higher the 



22 ◆ B 3 Power Devices and Systems – Exercise 3B. MOSFETs (6.6.5) 

© 2015 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

tsw/Ts ratio, the more important this decrease is; for example, a ratio of 0.001 corresponds to 
tsw = 100 ns at fs = 10 kHz, or tsw = 10 ns at fs = 100 kHz. 

3.3.f. Switching frequency and MOSFET application 

It should be remembered that our aim has been to assess the effect of transistor power loss only. 
In a real circuit, power losses are also present in the diode and the passive components (inductor and 
capacitor). They cause a further decrease in efficiency and voltage conversion ratio, for both high 
and low duty cycle values. 

The effectiveness of both the inductor and the capacitor is tightly linked to their values. As 
shown in Ref. B and Section 3, assuring a constant current flow requires an adequately large 
inductance, and eliminating the output voltage ripple needs a large enough capacitance. It therefore 
follows from (3.2) and (3.15) that these elements must have an adequate energy storage capability 
which in turn requires important dimensions. At the same time, passive element stay resistance will 
be large which will result in an increase in converter power loss and a decrease in its efficiency. 

However, let us take a look at Fig. 4 which—as far as waveform shapes are concerned—applies to 
both the inductor with its current and to the capacitor with its voltage. From this set of plots, it can 
be deduced that if the duration of both sub-intervals is decreased proportionally—which is 
equivalent to increasing the switching frequency fs—the current will rise and fall by a smaller 
amount. The ripple will therefore be minimised and so the passive element will become more 
effective. The output voltage will not be affected because—as shown in ref. B—it is not dependent on 
the switching period Ts but on the duty cycle D which is the mutual ratio of sub-intervals’ durations. 
An inverse reasoning leads to the conclusion that a same effectiveness can be obtained using an 
inductor with smaller inductance. The same applies to the capacitor’s capacitance. 

The above conclusion is the main reason for a high operating frequency of any switched-mode 
power converter. However, the relationships derived in Ref. F and in Section 3.3.f reveals that this 
causes the dynamic power loss in the transistor to increase. This can only be compensated by using 
a semiconductor switch with high switching speed, i.e., shorted switching times, the decrease in 
efficiency being dependent on the tswfs product (cf. Fig. 7). At present, MOSFETs are the controlled 
power semiconductor devices with the shortest switching times. This explains their dominance in 
switched-mode DC/DC power converters. 

Additional profits from MOSFET application comes from the field-effect control mechanism that 
results in: 

1º very low a drive  power (both with respect to the power processed in the system 
and to the power loss in the transistor’s main circuit) which does not lower the 
system efficiency as it is in the case of the current-driven BJTs; 

2º the possibility to drive the transistor directly from the outputs of integrated 
circuits (as driving signal is essentially a voltage and not a current), which 
simplifies the realisation of digital control systems. 
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3.4. Power-based approach to converter analysis 

3.4.a. Relation of voltage conversion ratio to efficiency 

A simple comparison of Figs. 6(a) and 6(b) leads to the significant observation that the deviation 
from the ideal conversion characteristic is the more apparent, the more efficiency deviates from its 
ideal value (η = 1).Intuitively, this can be explained as follows. Producing a specific output voltage V 
requires a current of V/R to flow through the receiver and therefore to deliver to the output a 
specific power equal 
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At an efficiency of η < 1, a portion of the input power is lost in the converter and therefore does not 
reach the receiver. If so, then the output power is less; hence, by reversing the above formula to the 
form 

 RPV o=  (3.46) 

we come to the conclusion that the output voltage will be less than expected. 

To express the above relation quantitatively, one must refer to the energy equation of the 
converter, i.e. to the relationship between the active input and output power. It follows directly from 
the definition of efficiency: 
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Assuming a constant input voltage, the active input power Pi is given by equation (3.31), while the 
output power is expressed with equation (3.45).The above equation can therefore expanded to 
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As we stated in Section 3.3.a, the input current is equal to the inductor current for the time the 
transistor is on, which is what we derived (3.27) from. That relationship is also valid for a lossy 
converter, as it was derived from Kirchhoff’s current law applied to the node in which the 
semiconductor switch connects to the choke; it must be always maintained, regardless of energy loss 
in the system. In turn, from Kirchhoff’s current law for the output node and from the assumption of 
ideal filtration, we obtained (3.21). Both currents (the input and the output ones) can therefore be 
expressed through the DC component of the inductor current: 
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By comparing the above result to the voltage conversion ratio for the ideal (lossless) converter 
(see Ref. B) 
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 DKU =(id)  (3.51) 

we find that the voltage conversion ratio for the real (lossy) buck converter is lower by a ratio equal 
to this converter’s efficiency: 

 (id)UU KK η=  (3.52) 

In other words, if we apply a some specific voltage Vg at the converter’s input and will control 
its transistor using a signal with a specific duty cycle D, then in a real buck converter we will obtain 
an output voltage less than in an ideal converter, by a ratio equal to the efficiency of the former. 

Note that the result obtained is consistent with the relationships demonstrating the impact of 
static power loss in the transistor on circuit operation, derived in Section 3.3. This is because voltage 
conversion ratio (3.41) and efficiency (3.42) are in fact related to each other through (3.50). 

3.4.b. The impact of power loss on the current input 

Finally, let us return to the discussion started in Section 3.3.a. The result obtained there 
[equation (3.29)] can also be reached by means of energetic analysis, which is even simpler because 
by transforming (3.48), we directly get 
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The obtained relationship is in fact a generalisation of equation (3.27), which can be seen when 
(3.50) is substituted into the latter. That equation is valid only for a specific topology: the buck 
converter. In contrast, the energy equation (3.48) and the relationship (3.53) are universal: true not 
only for the real (lossy) buck converter but also in general for any DC converter. This is because the 
relationships used to derive them were not linked to any specific circuit topology, nor were they 
founded on the assumption of unit efficiency. 

Formula (3.53) allows the designer to predict the input current necessary to convert the voltage 
at a given ratio KU, at a given load Io and an assumed efficiency η. It tells that the DC component of 
the input current is: 

1º proportional to the output current by a ratio inverse to the ratio of voltages 
(Ii(0) / Io ∝ V / Vg), 

2º inversely proportional to the converter efficiency (which is a number less than 1 
so dividing by it means increasing the result). 

Thus, the converter will draw a greater input current (meaning the DC component) for: 

1º a higher output to input voltage ratio, which means that when a converter steps 
down the voltage, then the input current is less than the output current, and vice 
versa, 

2º a less efficient inverter, which follows directly from the energy equation (3.48) 
because for a given input voltage Vg, if efficiency η is lower, then delivering a 
given output power Po requires a greater input current to flow in order for the 
left-hand and the right-hand sides of the equation to match.  
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C 

Experiment 

4. Measurements 

4.1. The measurement set-up 

A general schematic of the non-isolated buck DC/DC converter under investigation is shown in 
Fig. 8. Banana sockets at both extremities enable connecting a power supply (input voltage Ui) and a 
receiver (load) RL. Permanently mounted in the circuit are: a semiconductor switch, i.e., the 
transistor T and the diode D, and the input capacitor Ci, whose task is to ensure a constant input 
voltage. A blue 2-pin screw terminal block enables mounting the choke (inductor) L or making a 
short-circuit. The capacitor C is mounted in additional banana connectors transversely plugged into 
the receiver’s connectors. 

Circuit component values are: 

� load resistance RL = 4,7 Ω, 

� choke inductance L = 150 µH, 

� output capacitor capacitance C = 100 µF. 

Voltage potentials at the most important nodes of the circuit are accessible through banana 
sockets. Voltage measurements with oscilloscope probes are done using banana connectors with 
leads that enable attaching a probe. These connectors may be freely moved depending on current 
measurement needs. Current waveform observation is possible with clamping a current probe on 
one of the wires led out above the front panel (iL, iT, iD) or on a wire directly connected to the 
circuit’s input or output (ii, io). 

The pulse waveform ug driving the transistor comes from an external function generator (ugen). 
As the ground of the generator is earth-connected, grounds of all voltage probes (which are also 
earth-connected) would have to be connected to the same point. This would considerably hinder 
measuring voltages with respect to other nodes; therefore, an insulating semiconductor integrated 
circuit (an optocoupler) has been used, containing a light-emitting diode, a photodiode and a suitable 
conditioning circuit. 

The signal ugen coming from the generator passes through the optocoupler and is applied as ug to 
the input of the gate driver. The driver outputs a waveform of identical shape but optimised for fast 
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power MOSFET switching: with a higher top level and steeper edges, also ensuring a sufficiently 
high instantaneous current.  

The drive voltage ug after passing through the optocoupler is accessible in a banana socket. 
However, it is only applied at the transistor’s gate after a button on the front panel (omitted in Fig. 
8) is pushed: a green one (to switch on for the time the button is kept pushed), or a red one (to 
switch on permanently). A yellow light indicates that the driver is activated. 

The control (drive) circuit, i.e., the optocoupler’s output and the gate driver, require a separate 
power supply UGG. To energise the circuit, two power supplies will be used: 

� a high current capability one, for the power loop (Ui), 

� a standard one, for the control circuit (UGG). 

Depending on laboratory stand, oscilloscope images are recorded using WaveStar for 
Oscilloscopes (for the TDS224 oscilloscope) or OpenChoice Desktop (TDS1002B oscilloscope) 
applications. An appropriate procedure is described further in this manual with oscilloscope type 
designation given in cases where procedures differ. 
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Fig. 8. Schematic of the buck DC/DC converter experimental set-up 
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4.2. Preparation for measurements 

Configuring the measurement set-up 

A block diagram of the measurement set-up is presented in Fig. 9 for two laboratory stands 
where this exercise can be carried out. It should be assembled and configured in the way described 
below and following the specified order of actions. If a specific oscilloscope model appears in a given 
step, it means that this step applies to this particular model, while it should not be carried out when 
another model is used. 

To save time, you should proceed with subsequent steps in parallel with step 1. 

1. Turn on your computer. After logon is completed, turn on the oscilloscope and set up its 
connection to the computer proceeding strictly according to the short manual available at the 
laboratory stand. 

2. Ensure that power supplies are off. Connect: 

� a power supply with minimum current capability of 10 A and a minimum voltage 
capability of 40 V (which parameters are given on its housing), to the Ui input on the 
circuit’s panel, 

� one of the adjustable sections of a standard 2- or 3-section power supply, to the control 
circuit supply input (UGG). 

Do not safety-ground power supply using GND terminals. 

3. Set the control circuit power supply into Independent mode using two buttons in the middle of 
its front panel. 

4. Turn all the knobs of both power supplies to zero (extreme counterclockwise position). 

5. Connect the receiver RL, which is a set of resistors mounted on a heat sink, to the output (uo) of 
the circuit under investigation. 

6. Using a bare shorting wire available at the laboratory stand, short the two terminals of the blue 
screw terminal block. 

7. Using a T-joint, connect the output of the function generator (Main Output) to both: 

� the ugen input of the circuit under investigation and 

� [TDS224] the channel 3 input of the oscilloscope, 

� [TDS1002B] the external triggering (Ext Trig) input of the oscilloscope. 

8. Connect voltage probes with 1:10 attenuation ([TDS1002B] which is selected with a switch on the 
probe body, 10x) attached to oscilloscope inputs so as to measure: 

(a) the transistor’s gate drive voltage ug on channel 1; 

(b) [TDS224] the converter’s output voltage uo on channel 2. 

The grounds of the voltage probes are connected to each other and connected to the mains 
protective ground inside the oscilloscope; therefore they must be connected to the same 
potential. Other connection may result in current flow through the oscilloscope and damage 
of its input circuitry! 

9. Generate the driving waveform: 

(a) turn on the function generator; 

(b) from the web page, obtain and write down the converter switching frequency fs;  
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Fig. 9. Block diagram of the measurement set-up for time waveforms recording: (a) with the TDS224 
oscilloscope; (b) with the TDS1002B oscilloscope 
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(c) on the generator: 

A value entered with the keyboard is confirmed by pushing an appropriate unit button to the 
right. 

� choose rectangular wave (Func button), 

� set amplitude (Ampl) to 10 V (peak-to-peak value, Vpp), 

� set frequency (Freq) to the one determined above, 

� set duty cycle (Duty) to D = 0.35 (the duty cycle is expressed as percentage on the 
generator). 

Before proceeding, connections in the circuit must be checked by the teacher! 

While performing the next step, pay special attention to not exceeding at any time the value 
of 18 V. Otherwise, integrated circuits inside could be damaged. This step should first be 
read in its integrity; only then you should proceed with the described actions. 

While performing the next step, the current drawn from the power supply shown on its 
ammeter should be of the order of tens of milliamps if the converter operates correctly. If 
you observe something different, turn off the power supply and ask the teacher to check the 
circuit again. 

10. Supply the control circuit: 

(a) turn on the control circuit power supply; 

(b) slightly increase the current limit of the appropriate section (Current knob) so as the red 
current limiting mode indicator (C.C.) goes out; 

(c) set the supply voltage (Voltage knob) to 10 V. If the current limiting mode is activated in the 
course of setting (the red indicator lights up), first decrease the voltage (turn the Voltage 
knob counterclockwise) so as the red indicator extinguishes, next increase the current limit 
and only after that try to increase the voltage again; 

(d) after voltage is successfully set, increase the current limit by approximately the same 
amount that is has been set until now (at a guess). 

11. Check whether the gate driver is switched off, which is indicated by the yellow light being off. 
Otherwise, switch it off by pushing the red button. 

Setting up the oscilloscope    

12. Using the oscilloscope communication software, upload to the oscilloscope the appropriate 
initial settings: 

[TDS224] 

� from the menu choose File ‣ Open and open the file ustawienia_3b_przeb_tds224.sht; 
choose Offline in the dialog that appears; 

� on the list displayed in the left panel, unfold the installed oscilloscope ‣ Data ‣ Settings; 

� in the settings file window, select its entire contents and drag them to the Full Setup 
item in the left side panel using the mouse; 

� wait for the introduction of settings on the oscilloscope to complete, which process is 
indicated by changes of elements on the screen (letters, numbers, curves). 

[TDS1002B] 

� switch to the Get & Send Settings tab; 

� click Open and read the file ustawienia_3b_przeb_tds1002b.set; 

� click Send Settings; 

� return to the Screen Capture tab. 

13. Using CH1/2/3/4 Menu buttons on the oscilloscope, display the waveform from channel 1 and 
hide waveforms from all the other channels. 
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On the oscilloscope’s screen, a constantly refreshed and stable pulse wave should be seen, which 
is among others indicated with the message “Trig’d” (Triggered) displayed above the graticule. If 
this is not the case, ask the teacher to check oscilloscope settings. 

CHx Menu buttons (where x is channel number) cause toggled displaying and hiding the waveform 
form a given oscilloscope channel. When a given waveform is displayed, this is indicated by an arrow 
left of the graticule showing the zero level as well as channel symbol “CHx” under the graticule. 

14. Adjust: 

� time base and trigger event position (Sec/Div and Position knobs) so that 3 to 5 periods of 
the ug waveform can be seen on the screen (the trigger moment indicated with an arrow 
above the graticule must be located within the screen, i.e., it cannot be located at either 
graticule edge); 

� channel 1 gain and zero level position (CH1 Volts/Div and Position knobs) so that the 
waveform is clearly visible, is located at the very bottom of the screen and occupies 
approximately 1 division vertically. 

Short spikes or oscillations present in waveforms should be always disregarded throughout 
this exercise. 
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4.3. Converter component roles 

Supplying the circuit 

1. Make sure that no wire touches the load resistor, its heat sink, nor the heat sink found at the 
back of the converter’s enclosure. This also applies to voltage probe cables. Otherwise, wire 
insulation could melt. 

The above conditions must be met throughout the entire exercise! 

2. Supply the power circuit: 

(a) turn on the power circuit supply; 

(b) set the current limit to maximum (Current Coarse knob); 

(c) from the web page, obtain and write down the input voltage Ui; 

(d) slowly set the voltage to the value determined above (Voltage Coarse and Fine knobs), 
checking whether no constant current flow is indicated by the power supply’s ammeter; in 
the opposite case, turn off the power supply and ask the teacher to check the circuit again. 

After performing the next step, if the converter operates correctly, the current drawn from 
the supply as indicated by its ammeter should be close to, but not greater than predicted for 
an ideal converter, equation (3.30) [for any necessary values, see Section 4.1, step 4.2/9(c) and 
step 2(c) above]. If anything else is observed, turn off the power circuit supply and ask the 
teacher to check the circuit again. In the course of the exercise, this current will reach higher 
values. 

3. Turn on the converter in a way to ensure its operation without problems in the entire required 
range of the duty cycle: 

(a) switch the transistor gate driver on using the red button; 

When the converter is operating (the gate driver is on and the power input is supplied), 
important currents and voltages may be shown on the meters of the power supply. This results 
from transmission of fast disturbances while the power supply is not earth-grounded. This does 
not indicate incorrect circuit operation. 

(b) check whether the current limiting mode has not been activated in the control circuit power 
supply; if it has, increase its current limit; 

(c) set the maximum duty cycle on the function generator, i.e. 0.8; 

(d) repeat step (b); 

(e) restore the duty cycle of 0.35 

Setting up voltage measurement 

4. [TDS224] Display the channel 2 waveform (CH2 Menu). Adjust channel 2 gain and zero level 
position (Volts/Div and Position knobs) so that the waveform is clearly visible, is not 
superimposed on the ug waveform and occupies approximately the lower 1/3 to 1/2 (not more) of 
the screen vertically. 

5. [TDS1002B] Display the output voltage uo on the oscilloscope without losing the image of the ug 
voltage: 

(a) save the drive voltage ug waveform in the memory of the oscilloscope: 

� push Save/Recall, 

� using the appropriate button beside the screen, set Action to Save Waveform, 

� select saving to oscilloscope memory, Save To: Ref, 

� set Source to channel 1 (CH1), 
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� select destination as Memory A, To: Ref A, 

� push Save; 

From this moment on until the end of exercise, under no circumstances should you 
modify the time base (Sec/Div) nor the triggering event position (Horizontal Position)! 
This would de-synchronize oscilloscope images relative to each other and consequently 
would disable their analysis during result elaboration. 

(b) display the ug waveform from the Memory A by pushing Ref Menu and then, using an 
appropriate button beside the screen, set Ref A to On; 

The ug waveform coming from the oscilloscope memory should become displayed in the 
background of the screen. This can be checked by slightly moving the ug waveform coming from 
channel 1 using the Vertical Position knob. 

(c) transfer the channel 1 probe so that to measure the output voltage of the converter uo; 

(d) adjust channel 1 gain and zero level position (Volts/Div and Position knobs) so that the 
waveform is clearly visible, is not superimposed on the ug waveform and occupies 
approximately the lower 1/3 to 1/2 (not more) of the screen vertically. 

Setting up current measurement 

6. Configure the current probe amplifier and its connection to the oscilloscope following the short 
manual available at the laboratory stand. Take into account that in the worst case, the current in 
the circuit can reach a value equal to the quotient of the input voltage Ui [see step 2(c)] and the 
load resistance RL (see Section 4.1). The amplifier’s output should be connected to the 
oscilloscope’s last channel (4 or 2 as appropriate). Obligatorily read and follow the oscilloscope 
configuration guidelines given in that manual. 

7. Set DC coupling on the current probe amplifier. 

8. Clamp the current probe around the wire that leads the inductor (not present at the moment) 
current iL so that the positive current direction indicated by the arrow at the end of the probe is 
in line with reality (see Fig. 8). 

9. Show the iL waveform on the oscilloscope (use an appropriate CH1/2/3/4 button) and adjust: 

� the gain along the measurement path (on the amplifier or on the oscilloscope, as 
described in the probe manual, not in any other way), and 

� waveform position, using the Position knob for the appropriate channel (on the 
oscilloscope), 

so that the current waveform is clearly visible from its zero level, indicated by an arrow with 
channel number left of the graticule, to its peak value, that it is not superimposed on other 
waveforms and occupies approximately the upper 1/3 to 1/2 of the screen. 

Effect of components on circuit operation    

10. Record the set of 3 waveforms {ug; uo; iL}: 

[TDS224] 

(a) in WaveStar application, create a new sheet of the type YT Sheet; 

(b) drag the 3 waveforms displayed on the oscilloscope screen (ug, uo, iL) from the side panel 
(Local ‣ oscilloscope designation ‣ Data ‣ Waveforms ‣ channel designation) to the YT Sheet 
created; 

Once dragged, it is sufficient to refresh waveforms using the Refresh Sheet button or choosing 
View, Refresh Datasheet from the menu. 

A waveform can be deleted from a sheet by clicking on its number left to the graticule and 
pressing the Delete key. 
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(c) save the datasheet, containing all the waveforms 3 together, in WaveStar format (SHT), 
using the Save Datasheet button or selecting File ‣ Save Datasheet As from the menu; 

Do not use the Save Worksheet function, which does not save any measurement data, only names 
of open datasheets. 

(d) write down the conversion factor setting of the current probe amplifier (see the “Current to 
voltage conversion” section in the manual for the probe used). 

[TDS1002B] 

(a) in the OpenChoice Desktop application, switch to the Screen Capture tab; 

(b) download the screen image to the computer by clicking Get Screen; 

(c) save the oscilloscope image using a graphic format by clicking Save As. 

11. Insert the choke L in the circuit: 

(a) detach the current probe from the circuit; 

(b) switch the gate driver off, then turn off the power circuit supply; 

(c) remove the shorting wire from the blue screw terminal and connect the choke in its place; 

(d) place the shorting wire back in the bag in order to prevent its loss; 

(e) turn on the power circuit supply, then switch the gate driver on; 

(f) re-clamp the current probe around the wire that leads the inductor current iL. 

12. Without changing any settings on the oscilloscope nor on the current probe amplifier, record 
the waveform set again: 

[TDS224] 

(a) refresh the YT Sheet contents using the Refresh Sheet button or choosing View ‣ Refresh 
Datasheet from the menu; 

(b) save the datasheet in WaveStar format (SHT). 

[TDS1002B] 

(a) download the screen image to the computer by clicking Get Screen; 

(b) save the oscilloscope image using a graphic format. 

13. Insert the capacitor C in the circuit (keep the choke inserted): 

(a) detach the current probe from the circuit; 

(b) switch the gate driver off; 

(c) to the circuit’s output (uo), in parallel to the load (according to Fig. 8, see the description in 
Section 4.1), connect the capacitor paying attention to its proper polarity (negative terminal 
is marked on its case); 

Mounting correctness must be checked by the teacher! 

(d) switch the gate driver on; 

(e) re-clamp the current probe around the wire that leads the inductor current iL. 

14. Repeat step 12. 

SPDT semiconductor switch 

15. Optimise current measurement path settings for the present measurement conditions: 

(a) modify the gain (on the amplifier or on the oscilloscope, as described in the probe manual) 
and waveform position (Position knob of the oscilloscope) so that they are appropriate for 
the presently observed values of current, whose waveform should occupy approximately the 
upper 1/3 to 1/2 of the screen from its zero level to its peak value; 

(b) [TDS224] write down the present conversion factor setting of the current probe amplifier; 
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(c) [TDS1002B] record the set of waveforms {ug; iL} with current settings—download the image 
and save using a graphic format. 

Special attention is required during the following step so that different circuit points are 
not accidentally shorted with ground connectors of oscilloscope probes. 

16. * Move the voltage probes: 

[TDS224] 

(a) detach voltage probes (both tips and ground connectors) from the circuit; 

(b) attach ground leads of both probes to the same point, the common node for the transistor 
(source) and the diode (cathode); 

(c) attach probe tips so as to measure: 

� the voltage across the diode uD on channel 1, 

� the voltage across the transistor uT on channel 2; 

(d) if needed, adjust gains and zero levels of channels 1 and 2 (Volts/Div, Position). 

 [TDS1002B] 

(a) detach the voltage probe from the circuit; 

(b) attach the probe ground to the common node for the transistor (source) and the diode 
(cathode); 

(c) attach the probe tip so as to measure the voltage across the diode uD; 

(d) if needed, adjust the gain and the zero level of channel 1 (Volts/Div, Position) so that this 
waveform does not overlap the remaining two. 

17.  [TDS224] Record a complete set of 3 waveforms {iL, iD, iT } (* 5 waveforms {uD, uT, iL, iD, iT }): 

(a) create a new YT Sheet; 

(b) to the YT Sheet, drag ug and iL (* uD, uT and iL) waveforms, however without saving the sheet 
for now; 

(c) without changing any settings, clamp the current probe so as to observe the diode current 
iD, keeping the measurement positive direction in line with reality (see Fig. 9); 

(d) download the current waveform to the computer by dragging the appropriate channel again 
(do not delete nor refresh the waveforms downloaded previously, do not save now); you are 
only allowed to change waveform colour or slightly shift it with respect to the inductor 
current; 

(e) without changing any settings, clamp the current probe so as to observe the transistor 
current iT, keeping the measurement positive direction in line with reality (see Fig. 9); 

(f) download the current waveform to the software by dragging the appropriate channel again 
(do not delete nor refresh the waveforms downloaded previously); you are only allowed to 
change waveform colour or slightly shift it with respect to the currents downloaded 
previously; 

(g) save the datasheet containing the 3 (* 5) downloaded waveforms in WaveStar format (SHT). 

18. [TDS1002B] Record sets of waveforms {ug, iD} and {ug, iT} (* {ug, uD, iD} and {ug, uT, iT}): 

(a) without changing any settings, clamp the current probe so as to observe the diode current 
iD, keeping the measurement positive direction in line with reality (see Fig. 9); 

(b) download ug and iD (* ug, uD and iD) waveforms and save using a graphic format; 

(c) * attach the voltage probe tip so as to measure the voltage across the transistor uT; 

(d) * if needed, adjust channel 1 gain and zero level (Volts/Div, Position); 

(e) without changing any settings, clamp the current probe so as to observe the transistor 
current iT, keeping the measurement positive direction in line with reality (see Fig. 9); 

(f) download ug and iT (* ug, uT and iT) waveforms and save using a graphic format. 



Measurements C 4 ◆ 35 

© 2015 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

19. [TDS1002B] Hide the ug waveform coming from the oscilloscope memory: push Ref Menu on the 
oscilloscope and set Ref A to Off. 

20. Switch the gate driver off, then turn off the power circuit supply. 
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4.4. Electric power conversion with the buck converter 

Measurement of converter characteristics 

A block diagram of the measurement set-up is shown in Fig. 10 where connections to be created 
or modified in the way described below are drawn in black; gray lines represent existing 
connections that do not change. 

To make exercise realisation more efficient, one person should perform step 1, while the second 
one should start performing steps 2–3 in parallel. 

1. Using the oscilloscope communication software, introduce settings that will enable measuring 
the transistor current duty cycle: 

[TDS224] 

� from the menu, select File ‣ Open and open the file ustawienia_3b_char_tds224.sht in the 
next dialog box while selecting Offline; 

� in the file window, select all the instructions and using the mouse, drag them to the Data 
‣ Settings ‣ Full Setup item in the left side panel. 

[TDS1002B] 

� go to the Get & Send Settings tab; 

� press Open and read the file ustawienia_3b_char_tds1002b.set; 

� press Send Settings. 
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Fig. 10. Block diagram of the measurement set-up for static characteristics of the converter 
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2. Enable the measurement of the input and the output voltages: 

(a) in parallel to the input (Ui) and in parallel to the output (uo), considering the way the 
capacitor should now be connected as shown in Fig. 10, connect two CD771 multimeters so 
that to enable voltage measurement; 

(b) switch the multimeters to their voltage measurement mode (V); 

(c) with the blue button, set the multimeters to the DC component measurement mode (the ⚎ 
symbol on the display). 

3. Enable the measurement of the input and the output current: 

(a) in series with the input (Ui), i.e. between the power circuit supply and this input, and in 
series with the output (uo), i.e. between this output and the receiver, considering the way the 
capacitor should now be connected as shown in Fig. 10, connect two M­3860M multimeters 
so that to enable current measurements of a few amps; 

(b) switch the multimeters to their current measurement mode considering the current value 
mentioned above; 

(c) with the AC/DC button, set the multimeters to the DC component measurement mode (“AC” 
symbol absent from the display). 

If the battery discharge indicator (a battery symbol) shows up on the meter’s display, do not 
continue measurements but ask the teacher to replace the battery. Otherwise meter 
indications may become erroneous. 

Before proceeding, meter connections must be checked for correctness by the teacher. 

4. Turn on the power circuit supply, next switch the gate driver on. 

Do not touch the load resistors because of the risk of scald. Once again ensure that no wires 
touch the resistors nor the heat sink. 

5. Obtain a correct measurement of the transistor current pulse width: 

(a) change the gain in the current measurement path, in accordance with the current probe 
instruction manual, and possibly the waveform vertical position (Vertical Position knob) so 
that the current pulse top appears near the upper boundary of the display (it can even go a 
little beyond) and most of the spike visible at the beginning of the pulse is out off the 
display; 

(b) change the time base (Sec/Div) and the trigger event position (Horizontal Position) so that a 
(one) single pulse can be seen, occupying the largest possible part of the screen horizontally; 

(c) check that a relatively stable value is displayed in the right panel on the screen, in the 
measurement field described as Source: Ch2 or Ch4 (as appropriate), Type: Pos Width (brief 
distortions of this indication may happen from time to time), and that this value corresponds 
to the actual pulse width which should be read out from the screen using the graticule; ask 
the teacher for help otherwise. 

6. For 7 to 15 measurement points set by the duty cycle D varying from its minimum to its 
maximum value possible with the generator used, i.e. from 0.2 to 0.8, write down the following 
measurement results: 

(a) from the oscilloscope, transistor current pulse width tp(iT), each time controlling the 
correctness of the image and (roughly) of the value displayed as in point 5 and making 
appropriate adjustments to the settings if necessary; 

Do not waste time for recording the waveform from the oscilloscope as it will not bring anything to 
result analysis which cannot be brought by simply writing down the pulse width displayed which, 
however, takes less time than downloading the waveform and its saving to a file. 

(b) from the multimeters, the DC component values of the input voltage Ui, the input current 
Ii(0), the output voltage Uo and the output current Io. 
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Similar to our theoretical analysis, we assume that the ripple in the input and the output voltages is 
negligible and therefore the ui, uo and, consequently, io can be considered as constant over time. It is 
not however possible in relation to the input current ii; the result of multimeter measurement must 
therefore be denoted with the subscript “0” to clarify that it is its DC component only. 

7. Set the duty cycle D = 0.5. 

Measurement completion 

8. Switch the gate driver off, next turn off the power circuit supply and next, the control circuit 
power supply. 

9. On the oscilloscope, turn off bandwidth limiting in the current measurement channel by pushing 
CH2 or CH4 Menu as appropriate and setting BW Limit to Off using an appropriate button right 
of the screen. 

10. Turn off the multimeters. 

11. Disconnect the current probe from the circuit. 

12. Remove the choke and tighten back the screws in the terminal block. Remove the capacitor. 
Place the choke and the capacitor in the bag together with the bare shorting wire. 

13. Disconnect the set-up. 
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D 

Results 

5. Results Processing and Analysis 

5.1. Buck converter topology 

Semiconductor switch 

1. Based on the sets of waveforms 

[TDS224] {iL, iD, iT} (* {uD, uT, iL, iD, iT}) recorded in step 4.3/17 as well as {ug, uo, iL} recorded in step 
4.3/14: 

[TDS1002B] {ug, iD} and {ug, iT} (* {ug, uD, iD} and {ug, uT, iT}) recorded in step 4.3/18 as well as {ug, iL} 
recorded in step 4.3/15(c): 

(a) prove that the MOSFET and the diode act as an SPDT switch in the investigated circuit (see 
Refs. B and E); 

(b) determine the link between the ug voltage and the state of the transistor (on/off). 

[TDS224] The two sets of waveforms should be correlated based on the iL waveform which is 
found in both of them. 

[TDS1002B] The three sets of waveforms should be correlated based on the ug waveform which is 
found in each of them. 

2. * Analyse the off-state of semiconductor devices: 

(a) from the set or sets of waveforms analysed in step 1, read out value of the voltage across the 
transistor uT and of the voltage across the diode uD in their off-state, including the signs; 

(b) justify the values read out referring to circuit topology (i.e., electrical connections obtained 
with the semiconductor switch being on) in a given sub-interval (see Ref. B) and to known 
circuit operation parameters (see steps 4.2/9 and 4.3/2); 

(c) considering the voltage values read out, does either semiconductor device forward block or 
reverse block? is this in accordance with its capabilities? refer to static characteristics of the 
main circuit (see Ref. E); 
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(d) could the MOSFET be inserted in the circuit in the opposite direction, i.e., with drain and 
source interchanged? why? (see Ref. E). 

Circuit component roles 

3. Determine the role of each component of the buck converter circuit: 

(a) by comparison of sets of waveforms {ug, uo, iL} recorded in steps 4.3/10 (without passive 
components), 12 (with choke) and 14 (with choke and capacitor) state what the effect of 
inserting the semiconductor switch, the choke and the capacitor is; 

(b) what role may therefore be assigned to each of the above components (see Ref. B and 
Section 3)? 

4. * Analyse conditions in which the passive components operate: 

(a) based on known circuit component values (Section 4.1) and known switching frequency 
(step 4.2/9) state whether conditions are met for inductor and capacitor to properly fulfil 
their tasks, i.e. (3.14) and (3.24)? 

(b) state and justify whether waveforms analysed in step 3 prove that the considered 
relationships express indeed conditions for inductor and capacitor proper operation. 

5. Based on the set of waveforms {ug, uo, iL} recorded in step 4.3/14: 

(a) read out the following values: 

� output voltage Uo, 

� DC component of inductor current IL(0), 

� * inductor current ripple amplitude ∆IL; 

[TDS224] take into account the current probe conversion factor written down in step 
4.3/10(d); 

(b) justify the values obtained by referring to known circuit component values (Section 4.1) and 
known circuit operation parameters (steps 4.2/9 and 4.3/2; see Ref. B, and Section 3.2.d for a 
relationship for the DC inductor current). 



Results Processing and Analysis D 5 ◆ 41 

© 2015 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

5.2. Circuit characteristics and transistor’s effect 

Obtaining characteristics with respect to the controlling quantity 

1. Based on the results of measurements carried out in step 4.4/6, for each measurement point 
calculate (see Section 3.3): 

(a) actual (i.e. manifested in the power circuit, and thus in the transistor current, and not the 
one delivered from the generator to the input of the control circuit) duty cycle D, from the 
measured transistor current pulse duration tp(iT) and the known repetition frequency fs (see 
step 4.2/9); 

(b) average input power Pi, from the appropriate current and voltage measured (assuming the 
voltage is constant over time); 

(c) average output power Po, from the appropriate current and voltage measured (assuming the 
voltage is constant over time); 

(d) efficiency η, from its definition
 
(see Manual 0, Ref. B), 

(e) voltage conversion ratio KU , from its definition (3.40); 

(f) * current ratio Ii(0) / Io. 

Gather measurement and calculation results in Table 1. 

2. For each duty cycle value D, calculate and add to Table 1 (see Section 3.3): 

(a) voltage conversion ratio for the ideal (lossless) converter KU(id), from the analytical formula; 

(b) relative difference in voltage conversion ratio between the real and the ideal circuit  
(KU − KU(id)) / KU(id), based on the results from steps (a) and 1(e); 

(c) * KU / KU(id) ratio, based on the results from steps (a) and 1(e); 

(d) * the ratio of the measured current ratio Ii(0) / Io to its theoretical value, based on the results 
from step 1(f). 

3. For a dense set of duty cycle D values over its full possible range of [0; 1], so that it is possible to 
subsequently plot a curve covering the entire range from 0 to 1 and giving the impression of a 
smooth curve, calculate again the voltage conversion ratio of the ideal converter KU(id). Gather 
these results in a separate Table 2. 

Results analysis 

4. Based on data from Table 1, plot the characteristic of efficiency η as a function of duty cycle D. 

5. Analyse the obtained curve: 

(a) is the obtained efficiency level high or low as compared to linear-mode circuits (see Manual 
0, Refs. B and E)? 

(b) how does the efficiency change with the duty cycle? 

(c) * if we assume that power losses are mainly introduced by the transistor (determining 
whether it is indeed true, would require a much wider program of measurements), would the 
shape of the measured characteristics demonstrate the dominance of dynamic or static 
power loss, or a comparable contribution of both (see Section 3.3)? 

6. Illustrate the conversion characteristics of the circuit under investigation in combination with 
the ideal converter characteristics (all of the below as functions of the duty cycle D): 

(a) in one graph, include two characteristics of the conversion ratio, the measured one KU, based 
on Table 1, and the ideal converter one KU(id), based on Table 2; 

(b) in a separate graph, based on Table 1, present the relative difference in voltage conversion 
ratios (KU − KU(id)) / KU(id) as a function of the transistor current duty cycle D; 

(c) * in a separate, single plot, based on Table 1, present the proportion of the voltage 
conversion ratios KU / KU(id) and the efficiency η. 
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7. Analyse the course of the experimental characteristic in comparison with the theoretical one: 

(a) what is the sign (in plus or in minus) and the order of magnitude of the discrepancy between 
them in absolute numbers [graph of step 6(a) and Table 1] and in relative numbers [graph of 
step 6(b) and Table 2]? 

(b) does the above discrepancy vary with the duty cycle? in what way? 

(c) relate the above observation to the trend of the efficiency characteristic η = f(D); is there any 
regularity noticeable in this respect (i.e. characteristic trends), i.e. a correlation between the 
efficiency and the discrepancy between the voltage conversion ratios for the real and for the 
ideal converter, visible over the entire value range of D? 

(d) * refine the conclusion of sub-step (c) by performing a quantitative analysis: based on the 
graph produced in sub-step 6(c), determine whether, in accordance with theoretical 
predictions, the relationship (3.52) holds. 

8. * Analyse the relationship between the converter currents: 

(a) based on data from Table 2, plot the proportion of the measured current ratio Ii(0) / Io to this 
ratio theoretical value (specify what this value is); 

(b) based on the graph obtained, determine whether, in accordance with theoretical predictions, 
the relationship (3.28) holds and whether it is true for a real (lossy) converter. 

Transistor power loss minimisation 

9. Let us assume we want to increase the efficiency of the converter by reducing both the static 
PT,stat and the dynamic power loss PT,dyn in the transistor at least by a factor of two. What criteria 
should we apply in search for a better suited transistor? Base on eqs. (3.33) and (3.43) (see also 
Ref. F and Manual 3

A
, Ref. D). Express these criteria numerically in the form of inequalities 

based on the datasheet of the transistor used in the investigated converter. 

10. * If changing the transistor were not an option, what other action influencing its operation could 
be taken to increase the efficiency? Base on results from part A of this exercise. 
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E 

Information 

6. Expected Report Contents 

1. Waveforms of switch branch currents (* and voltages) across semiconductor devices, 
and the driving waveform, together with inductor current, labelled with 
current/voltage conversion factors of the current probe (for TDS224), according to 
step 5.1/1 
[TDS224] [i.e., {iL, iD, iT} (* {uD, uT, iL, iD, iT}) and {ug, uo, iL} sets] 
[TDS1002B] [i.e., {ug, iD}, {ug, iT} (* {ug, uD, iD}, {ug, uT, iT}) and {ug, iL} sets] 

2. Waveform analysis with respect to the SPDT switch action, according to step 5.1/1 

3. * Off-state voltage values across semiconductor devices with their justification, 
including formulae used and calculations made, together with references to 
properties of these devices, according to step 5.1/2 

4. Waveforms of driving voltage, output voltage and inductor current for three sets of 
converter components, put together on one page side by side or one under another, 
and their analysis, according to step 5.1/3 
(i.e., {ug, uo, iL} sets for the cases without passive components, with choke added and 
with capacitor added) 

5. * Conditions for proper operation of passive components given in numerical form, 
their comparison to values of components used and a reference to measurement 
results, according to step 5.1/4 

6. Voltage and current values read out of oscilloscope images and their justification, 
with formulae used and calculations made, according to step 5.1/5 

7. Table with calculation results of experimental efficiency and voltage conversion 
ratio (*  current ratio) characteristics, according to steps 5.2/1—2 

8. Table with calculated points along the theoretical conversion characteristic, 
according to step 5.2/3 

9. Efficiency characteristic plot and its analysis, according to steps 5.2/4—5 

10. Plots of the experimental conversion characteristic combined with the theoretical 
one, of the difference in voltage conversion ratios (* as well as of the proportion of 
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voltage conversion ratios combined with the efficiency) and their analysis, according 
to steps 5.2/6—7 

11. * Plot and analysis of the proportion of the current ratio measured to its theoretical 
value, according to step 5.2/8 

12. Numerically expressed transistor search criteria for reduced power loss, according to 
step 5.2/9 

13. * Proposal of another circuit modification permitting increasing efficiency, 
according to step 5.2/10 

7. Required Knowledge 

7.1. Prerequisites 

� Switched mode of circuit operation: a typical control signal waveform, duty cycle, 
switching period and frequency. 
(see Ref. B; Manual 0, Ref. B; Section 2.2) 

� Buck DC/DC converter operating principle: schematic, the SPDT switch and its 
operation, circuit reduced topology in the two sub-intervals of switching period, 
choke current waveform 
(see Ref. B and Manual 0, Ref. B) 

7.2. Test scope 

1. Switched mode of circuit operation: a typical control signal waveform, duty cycle, 
switching period and frequency. 
(see Refs. B and C; Manual 0, Ref. B; Section 2.2) 

2. Advantages and drawbacks of different converter types: electro-mechanical, linear-
mode electronic and switched-mode electronic. 
(see Manual 0, Refs. B and E) 

3. Buck DC/DC converter: schematic (with an ideal switch and with semiconductor 
switches), SPDT switch and its operation, role of either passive element. Reduced 
circuit topology in two sub-intervals of switching period. Inductor, transistor and 
diode current waveforms synchronised with switch driving signal (including specific 
voltage values and their link to circuit operating conditions). 
(see Ref. B and Manual 0, Ref. B) 

4. Definitions of efficiency and voltage conversion ratio. Experimental and theoretical 
conversion characteristics for the ideal (lossless) buck converter (formula and plot). 
Efficiency characteristics of the buck converter (plots), considering static and 
dynamic transistor power loss; effect of transistor parameters. Experimental 
efficiency characteristic; experimental characteristic of the relative difference in the 
voltage conversion ratio between the real and the ideal converters as a function of 
duty cycle; link between these characteristics including the theoretical relationship 
(a formula for the voltage conversion ratio containing the efficiency). 
(see Section 3.3; Ref. B; Manual 0, Ref. B; report) 

5. Favourable and unfavourable consequences of increasing switched-mode converter 
operating frequency; resulting requirements related to semiconductor devices. 
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Reasons for power MOSFET popularity. 
(see Section 3.3.f, report) 

When results included in your report are concerned, restrict to the qualitative aspect (character 
of relationships) and indicatory values. 
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